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Introduction 
SCM Viewer is an offline viewer for SCM-formatted binary files downloaded from Scanner Measurement RTUs. 
The 32-bit SCM Viewer application supports viewing, exporting and graphing of data contained within SCM 
files. 

SCM Viewer is required for viewing data files downloaded with ScanWin Lite. ScanWin PRO users have the 
option of viewing downloaded files within ScanWin or within SCM Viewer. ScanWin (Lite or PRO) can be 
configured to automatically initiate SCM Viewer after a data download. See the ScanWin Lite or ScanWin PRO 
manual for details. 

SCM Viewer’s easy-to-use interface offers a level of functionality that is equal to or greater than that available 
within ScanWin PRO.  

About This Manual 
The SCM Viewer User Manual  provides the information and procedures required to install, uninstall, and use 
SCM Viewer.  

This manual is intended for field technicians and managers who have a basic understanding of Microsoft 
Windows.® Prior knowledge of SCM Viewer is not required. 
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Chapter 1: Installing SCM Viewer 

Installing SCM Viewer 
To install SCM Viewer, perform the following steps: 

1. Open the ScanWin installation CD, and click on SCMViewer_B100N_Setup.exe.  

2. Follow the on-screen instructions. 

3. The Welcome Screen will appear. Close all Windows 
programs, then click the Next button. 

 

  

 

 

 

 

4. The License Agreement dialog is displayed.  Use the 
scroll bar to read the entire message.  Click the Yes button 
if you agree to the terms of the agreement and wish to 
continue the installation.    

Clicking the No button at this time or the Cancel button in 
later dialogs will cause the following “Setup is not 
complete” message to be displayed.   

 

 

 

 

You may continue the installation by clicking Resume, or terminate the 
installation by clicking Exit Setup. 
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5. Choose your default unit of measurement.   

This unit can later be changed using the program’s options 
settings. 

 

 

 

 

 

6. By default, the program files will be saved to your 
C:\BARTON\BDMS\PROGRAM\SCMVIEWER. If this 
location is acceptable, click Next to continue. 

 

 

 

 

 

 

7. To install the program in a different location, click on the Browse 
button. The window shown at right will appear. Navigate to the folder 
in which you wish to install the files, and lick OK. If the directory 
does not already exist, you must create it before you perform this step. 
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8. The SCM Viewer installation program gives you the 
option of choosing a program manager group or creating 
your own program manager group. 

Click Next to continue. 

 

 

 

 

 

9. The Start Installation dialog window will appear. Click 
on the Next button to install SCM Viewer. 

 

 

 

 

 

 

10. When the installation is completed, the dialog window at 
right appears, and a shortcut icon will appear on the 
desktop of your computer. Click Finish. 

 

 

 

 

Uninstalling SCM Viewer 
To uninstall SCM Viewer, select the application within the Control Panel>Add/Remove Program menu, or 
optionally, run the file ‘Unwise.exe’ within the install directory: C:\BARTON\BDMS\PROGRAM\ 
SCMVIEWER. Only application files will be deleted when the application is uninstalled, all data files and 
directories will remain on your hard drive. 
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Chapter 2: Using SCM Viewer 

About SCM Files 
An SCM file can contain up to five different types of data: 

• Configuration data of selected flowruns and/or system (“S”) data 

• Historical data (daily and hourly) of selected flowruns 

• Event data of selected flowruns noted and/or system (“S”) data 

• User change data of selected flowruns and/or system (“S”) data 

• Data logger data of selected data loggers 

By default, SCM files are saved to the following directory: c:\Barton\BDMS\Data\Reports. 

This destination directory is user-configurable, however. See the ScanWin PRO or ScanWin Lite manual for 
information on customizing the destination directory.  

Opening SCM Viewer 
To open SCM Viewer, click on the shortcut icon on the desktop of your computer, or click on the Start menu, 
navigate to the SCM Viewer application (NuFlo Measurement Systems>Barton SCM Viewer>SCM Viewer), and 
click to open the application. 

The Main Menu screen will appear. The main menu has four headings – File, 
Settings, Window and Help. 

File Menu 
The file menu consists of five menu options: Open, Send 
to Mail Recipient, Close, Recent Files and Exit. 
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Open 
Select File>Open to view a list of SCM files. 

Click on an SCM file to display a summary of file contents in the right column of the screen. 

The SCM File contents can 
contain the following 
information: 

• File name 

• SCM file format version 

• Number of flowruns within 
the file 

• Number of records within the 
file 

• The date and time the data 
was downloaded from a Scanner 

• The name of the node related to the data collected 

• Data: A summary of data types contained in the file, and the number of flowruns or dataloggers 
represented. An “S” indicates data that is specific to the entire system.  

• Range: The beginning and ending date/time of all data collections within the file. Not all data will have 
the same beginning and ending date/time, but all data will fall on the beginning or ending date or 
somewhere in between. 

To open the file, push the Open button. The screen shown on page 13 will appear. See Chapter 3 for a 
detailed explanation of parameters displayed. 

To close the dialog without opening a file, click the Cancel button. 
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Send to Mail Recipient 
The Send to Mail Recipient 
option allows a user to send an 
SCM file as an email attachment. 
To send a file, select the SCM 
file, then choose File>Send to 
Mail Recipient. A message is 
composed in the default e-mail 
program, and the SCM file will 
appear as an attachment.  Simply 
enter the recipient’s email address 
in the “To…” field and press 
Send to transmit the file via 
email. 

The Send to Mail Recipient 
option is active only when an 
SCM file is open. 
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Close 
Pressing the Close button will close the active open SCM file. 

Recent Files List 
The Recent Files List contains the four most recently opened SCM files. Any of these files can be opened 
simply by clicking on it. 

Exit 
Pressing the Exit button will close the application. 

Settings 
The Settings menu options (Options, Unit Type and 
Logging Level) allow the user to change settings 
affecting the application. Changes will not affect 
currently open SCM files, but will apply to any files 
opened after the settings are changed.  

 

 

Options 
The Options menu is the general dialog that specifies how data will be represented within the application. 
Changes made to this dialog become effective only after the ‘OK’ button is pressed. To exit the dialog 
without making changes, press ‘Cancel.’  

History Tab 
The History tab allows the user to specify how specific data will be displayed within the application. The 
settings are categorized under four main groupings: General, Spreadsheet, Graph, and Graph Settings. The 
user can change the following data (as shown in the column headings of the screen capture on page 15): 
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1) General 
• Name: The name NuFlo 

applications use internally 
to describe the data. 

• ID: The hex number 
NuFlo applications use 
internally for this data. 

• User Text: The name the 
user can set to describe 
the data. 

• Decimal Places: The 
number of decimal places 
displayed in the values 
shown within the 
application. If the 
Decimal Places setting is 
set at -1, then the decimal 
places will be identical to 
the decimal places used within the SCM file. 

2) Spreadsheet 
• Show: This checkbox determines whether or not the data is shown on the spreadsheet. If the checkbox 

is checked, the data is shown on the spreadsheet; if the checkbox is not checked, the data will not be 
shown on the spreadsheet. If the data is not shown on the spreadsheet, it cannot be shown on the 
graph either. 

• Column Width: This value is the width this data takes up on the spreadsheet. The column width can 
be changed on the fly by positioning the cursor on the right boundary of a column and dragging it to 
the right or left.  

3) Graph 
• Show: This checkbox determines whether or not the data is shown on the graph. If the checkbox is 

checked, the data is shown on the graph; if the checkbox is not checked, the data will not be shown on 
the graph. If the data is not shown on the spreadsheet, it cannot be shown on the graph either. 

• Color: The color used to draw the line of data on a graph.  To change the color, click on the color 
displayed and then select a new color. Press “OK” to select the color. Click “Cancel” to revert to the 
original color. 

• Min Range: Theminimum valueto beshown on the graph. This number is ignored if “Auto Min” is 
selected. 

• Auto Min: Automatically determines the minimum value to allow the bottom-most range data to be 
shown on the graph. 

• Max Range: The maximum value to be shown on the graph. This number is ignored if “Auto Max” is 
selected. 

• Auto Max: Automatically determines the maximum value to allow the bottom-most range data to be 
shown on the graph. 
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4) Graph Settings 
The Graph Settings box near the bottom of the screen allows the user to establish the number of days of 
data that are visible at one timeon the graph and to specify the background color of the graph.  All data is 
loaded into the graph. The range refers to how many days are visible in the default graph view.  The user 
can use the scroll bars to view additional data. 

Units Tab 
The Unit tab allows the user to specify the 
unit to use with each item of data. For 
historical data, the user can select 
different units depending upon the type of 
flowrun: gas, liquid or monitor. Units for 
configuration data are based upon 
categories and any changes here will 
affect all data within that category. 

To change a unit, simply select the cell 
with the old unit to view a dropdown 
menu. Then, choose a new unit from the 
dropdown options. If no dropdown menu 
appears, units are not applicable for the 
selected type of data, or the unit cannot  
be changed from this screen (and must be 
edited manually within the related 
scmviewer.ini file). 

Unit Type 
The Unit Type menu allows the user to select which unit format the application will use, either metric or 
Imperial. The default is set when the application is installed (see Chapter 1: Installing SCM Viewer). 

Log Level 
The Log Level menu sets the level of messages that will be written to the log file while loading an SCM file 
into the viewer. The following list contains the common settings. Level 20 is the default. 

    1 – Only error messages 

  10 – As above plus warning messages and summary 

  20 – As above plus basic conversion tracking 

  40 – As above plus more conversion tracking 

  50 – As above plus conversion processing details 

  60 – As above plus detailed tracking 

  80 – As above plus extensive tracking 

100 – As above plus internal details 
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110 – As above plus extensive details 

Window 
The Window menu allows the user to either select an 
open SCM file or automatically arrange the open files, as 
shown below. The Window options are available for 
selection only when an SCM file is open. 

 

 

Help 

About 
Through the About selection, a user can determine the 
version of SCM Viewer and view the end-user license 
agreement to which he or she agreed when installing the 
application. 

Manual 
Click on Manual to access an electronic copy of this 
document. 

Send File to NuFlo 
The Send File to NuFlo option is 
a shortcut for seeking technical 
support, and is active only when 
a file is open. When this menu 
item is selected, the default e-
mail program composes a 
message to to the NuFlo 
HelpDesk.  Attached to this 
message will be the SCM file 
you have open, as well as the log 
file that is associated with it. 

To aid technical support staff in 
solving the problem, add an 
explanation of the problem at the 
end of the message. 



SCM Viewer   

18 February 2006  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 



 Chapter 3: Viewing an SCM File 

February 2006 19 

Chapter 3: Viewing an SCM File 

Opening an SCM File 
From the Main screen, select 
File>Open to view the SCM files 
available for viewing. 

Click on an SCM file to display a 
summary of file contents in the right 
column of the screen. 

Click the Open button to fully display 
the contents of the file. 

The file contents is categorized by 
data type, with each data type stored 
under a separate tab (for example, 
Hourly History, Daily History, 
Configuration, etc.).  

When an SCM file is opened, the data 
is read from the file and populated 
under the appropriate tab. As the file 
loads, the progress is shown on the log 
tab and entries are added to the log, 
depending upon the log level. When 
the file load is complete, the loading 
progress bar will read “100%” and the 
Main screen will open with the left tab 
displayed for viewing. Only tabs that 
reflect data contained within the SCM 
file will be displayed.  

Above the tab, the following 
information is displayed: 

• Poll Date: the date/time the 
data was collected from the 
Scanner 

• Firmware: the firmware version of the Scanner from which data was collected 

• File: the file path of the file being viewed 
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Changing Column Width 
Hourly History, Daily History, and 
Configuration data are presented in tabular 
format. It may be necessary to adjust the 
default column width to properly view the data 
in table cells. To change the width of a 
column, position the cursor on the right border 
of the header cell in the column you want to 
change. When the cursor aligns with the 
border and changes shape, hold down the left 
mouse button and drag to widen the column.  
These changes will be saved and will be 
displayed the next time the application is run. 
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Hourly / Daily History Tabs 
The Hourly History and Daily 
History tabs show historical data 
from the SCM file. Sub-tabs allow 
the user to select the flowrun to be 
viewed. The sub-tabs are labeled 
with the flowrun name and 
[number]—for example, 
RUN001(#1). 

The columns shown for each flowrun 
depend upon the data contained 
within the SCM file and the columns 
that the user has selected for display.  
All spreadsheets show the date/time 
in the first column and the status 
flags for the associated date in the 
second column. To view what status 
flags are associated with each 
date/time, click on a cell within that 
row. Explanations of associated 
status flags are highlighted at the 
bottom of the screen. 

Buttons at the bottom of the screen 
allow the user to view the data in a 
graph, to export the data to a file, or 
to print one or all tabs. Right-clicking 
in a cell within the table displays a 
dropdown list with similar options, 
plus options to copy a selection or an 
entire sheet to the clipboard for 
pasting in another application. 
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Graph 
To view data from the active flowrun as a 
graph, click on the Graph button at the 
bottom of the main SCM Viewer screen. The 
data shown is dependent upon the data within 
the spreadsheet and any user-configurable 
options selected.  Since the graph appears in 
a window that is separate from the main 
SCM Viewer screen, users can tab through 
graphs of associated flowruns by keeping the 
graph dialog open and selecting a different 
flowrun tab from the Main screen. 

The parameter represented by the y-axis 
scale (on the left) is determined by the 
selection in the “Scale to use” dropdown 
menu above the graph. 

The user selects the types of data to be displayed in the graph by checking (or unchecking) the checkboxes in 
the legend below the graph. 

The range of data viewed on the screen can be changed by specifying a Start date and an End date at the top 
of the screen, or by using the zoom buttons. Regardless of the view displayed, the “Reset” button at the top of 
the screen will restore the default range view.  

Export from Graph Window 
The “Export” button at the bottom of the screen allows the user to 
copy, save, or email the graph in a variety of formats. To export 
the graph, click Export, select the format desired,  select a color 
setting, and press the appropriate button—Copy, Save, or Send—
at the bottom of the dialog screen. Click “Close” to return to the 
Graph screen. 

 

Print from Graph Window 
The “Print” button at the bottom of the screen allows the user to 
preview the graphical display before it is printed. To print a graph, 
click Print in the graph window, specify the printer, choose file 
setup options, orientation, margins, etc., and click Print in the 
Preview of Graph window.  Click “Close” to return to the Graph 
screen. 

 

Close 
The “Close” button at the bottom of the graph screen closes the graph dialog. 
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Export from Hourly / Daily History Tab 
Clicking on the Export button at the bottom of the main SCM Viewer screen exports all the data from the 
flowruns in a variety of file formats including Excel, comma delimited, text, HTML, and Microsoft Word.  

Print from Hourly / Daily History Tab 
Clicking on the Print button at the bottom of the 
main SCM Viewer screen sends data to a selected 
printer. Radio buttons located immediately above 
the Print button give the user the option of 
printing from only the selected flowrun (Current 
Tab) or all the flowruns included in the SCM file 
(All Tabs). 

Configuration Tab 
The Configuration tab shows the 
configuration data from the SCM file. Sub-
tabs allow the user to select the flowrun to be 
viewed, and a System sub-tab shows 
configuration data specific to the Scanner as a 
whole. 

Buttons at the bottom of the screen allow the 
user to export the data to a file, or to print one 
or all tabs. 

Right-clicking in a cell within the table 
displays a dropdown list with similar options, 
plus options to copy a selection or an entire 
sheet to the clipboard for pasting in another 
application. 

 

Export 
Clicking on the Export button at the bottom of the main SCM Viewer screen exports all the data from the 
flowruns in a variety of file formats including Excel, comma delimited, text, HTML and Microsoft Word. 

Print 
Clicking on the Print button at the bottom of the 
main SCM Viewer screen sends data to a selected 
printer.  Radio buttons located immediately above 
the Print button give the user the option of printing  
from only the selected flowrun (Current Tab) or all  
the flowruns included in the SCM file (All Tabs). 
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Events 
The Events tab shows the events data from the SCM file.  Sub-tabs allow the user to select the flowrun to be 
viewed, and a System sub-tab shows event data specific to the Scanner as a whole. 

Buttons at the bottom of the screen allow the user to export data to a file, or to print one or all tabs. 

Right-clicking in a cell within the table displays a dropdown list with similar options, plus options to copy a 
selection or an entire sheet to the clipboard for pasting in another application. 

Export All / Export 
Clicking on the Export All button at the bottom of the main SCM Viewer screen saves all events and user 
changes in a single file, ordered by number. Clicking on the Export buttons saves only events to the SCM file, 
ordered by number. The data is saved in a Word document format. 

Print 
Clicking on the Print button at the bottom of the main SCM Viewer screen prints the data to a selected printer.  
Radio buttons located immediately to the left of the Print button give the user the option of printing from only 
the selected flowrun (Print Current Tab) or all the flowruns included in the SCM file (Print All Tabs). 

User Changes 
The User Changes tab shows the user changes 
data from the SCM file. Sub-tabs allow the 
user to select the flowrun to be viewed, and a 
System sub-tab shows user change data 
specific to the Scanner as a whole. 

 

Buttons at the bottom of the screen allow the 
user to export data to a file, or to print one or 
all tabs.Right-clicking offers the user the same 
options as the buttons plus the ability to copy 
a selection to the clipboard. 
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Export All / Export 
Clicking on the Export All button at the bottom of the main SCM Viewer screen saves all events and user 
changes in a single file, ordered by number. Clicking on the Export buttons saves only user changes to the 
SCM file, ordered by number. The data is saved in a Word document format. 

Print 
Clicking on the Print button at the bottom of the main SCM Viewer screen prints the data to a selected printer.  
Radio buttons located immediately to the left of the Print button give the user the option of printing from only 
the selected flowrun (Print Current Tab) or all the flowruns included in the SCM file (Print All Tabs). 

ScanPLC 
If ScanPLC data exists in the SCM file, a 
ScanPLC tab will be displayed.   

The format for these events takes the 
information from a plc_evt.fmt initialization 
file. 

Buttons at the bottom of the screen allow the 
user to export data, to generate a report in 
Word format, or to print one or all tabs.Right-
clicking offers the user the same options as 
the buttons plus the ability to copy a selection 
to the clipboard. 

Export 
Clicking on the Export button at the 
bottom of the main SCM Viewer screen saves all data in a in comma delimited format. 

Report 
Clicking on the Report button at the bottom of the main SCM Viewer screen saves all data in Word document 
format. 

Print 
Clicking on the Print button at the bottom of the main SCM Viewer screen prints all data to a selected printer.   
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DataLoggers Tab 
Data logs can be used to log 
variables that are not included in the 
flowrun hourly logs or to log data at 
intervals other than hourly and daily. 
Data logs are useful as trouble-
shooting tools. 

The DataLoggers tab is very similar 
to the Hourly and Daily History tabs. 
Sub-tabs allow the user to select the 
datalogger to be viewed. The sub-
tabs are labeled with the datalogger 
number—for example, DL #1. 
Clicking on a sub-tab allows the user 
to view the associated historical data 
for that datalogger. 

The columns shown for each datalogger depend upon the data contained within the SCM file. 

Buttons at the bottom of the screen allow the user to view the data in a graph, to export the data to a file, or to 
print one or all tabs. Right-clicking in a cell within the table displays a dropdown list with similar options, plus 
options to copy a selection or an entire sheet to the clipboard for pasting in another application. 

Graph 
To view data from the active datalogger as 
a graph, click on the Graph button at the 
bottom of the main SCM Viewer screen. 
The data shown is dependent upon the data 
within the spreadsheet and any user-
configurable options selected.  Since the 
graph appears in a window that is separate 
from the main SCM Viewer screen, users 
can tab through graphs of associated 
dataloggers by keeping the graph dialog 
open and selecting a different datalogger 
tab from the Main screen. 

The parameter represented by the y-axis 
scale (on the left) is determined by the 
selection in the “Scale to use” dropdown 
menu above the graph. 

The user selects the types of data to be displayed in the graph by checking (or unchecking) the checkboxes in 
the legend below the graph. 

The range of data viewed on the screen can be changed by specifying a Start date and an End date at the top 
of the screen, or by using the zoom buttons. Regardless of the view displayed, the “Reset” button at the top of 
the screen will restore the default range view.  
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Export from Graph Window 
The “Export” button at the bottom of the screen allows the user to 
copy, save, or email the graph in a variety of formats. To export 
the graph, click Export, select the format desired,  select a color 
setting, and press the appropriate button—Copy, Save, or Send—
at the bottom of the dialog screen. Click “Close” to return to the 
Graph screen. 

 

Print from Graph Window 
The “Print” button at the bottom of the screen allows the user to 
preview the graphical display before it is printed. To print a graph, 
click Print in the graph window, specify the printer, choose file 
setup options, orientation, margins, etc., and click Print in the 
TeeChart Print Preview window.  Click “Close” to return to the 
Graph screen. 

 Close 
The “Close” button at the bottom of the graph screen closes the 
graph dialog. 

 

Export from DataLogger Tab 
Clicking on the Export button at the bottom of the 
main SCM Viewer screen exports all the data 
from the dataloggers in a variety of file formats 
including Excel, comma delimited, text, HTML 
and Word document. 

 

 

 

Print from DataLoggers Tab 
Clicking on the Print button at the bottom of the 
main SCM Viewer screen sends data to a selected 
printer. Radio buttons located immediately above 
the Print button give the user the option of 
printing from only the selected datalogger 
(Current Tab) or all the dataloggers included in  
the SCM file (All Tabs). 
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Log 
The Log tab shows the information that is 
logged as the file is  loaded. The amount of 
information depends upon the log level. If the 
file could not be loaded successfully, an 
explanation will  appear within the log. 

Right-clicking the log data pulls up a menu 
that has the same options as the buttons on 
this page and the ability to copy any selected 
text to the clipboard to be pasted in another 
application. 

 

 

Export 
Clicking on the Export button at the bottom of the main SCM Viewer screen exports the contents of the log 
into an HTML file. 

Print 
Clicking on the Print button at the bottom of the main SCM Viewer screen sends log data to a selected printer.  

Find 
Clicking this button allows the user to search for specified text within the logged information. 
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Chapter 4: Troubleshooting Information 

Troubleshooting Information 
This chapter is dedicated to identifying common errors and problems encountered through normal use of this 
product. This information is constantly being updated as new items are found. if your problem is not listed, 
contact the NuFlo Scanner HelpDesk at 1-877-805-7226 or (403) 291-4814. 

 

Problem: Unable to Install SCM Viewer 
 

Symptom: The operating system should provide a message similar to the following: 

 

 

 

Cause: Attempting the installation on a NT/2000/XP machine as a user without administrator rights.  This error 
commonly occurs when the machine is part of a Novell network. 

 

Solution: Log into the computer as a user with Administrator rights and re-run the install. 
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WARRANTY - LIMITATION OF LIABILITY:  Seller warrants only title to the products, software, 
supplies and materials and that, except as to software, the same are free from defects in 
workmanship and materials for a period of one (1) year from the date of delivery.  Seller does not 
warranty that software is free from error or that software will run in an uninterrupted fashion.  
Seller provides all software "as is".  THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, 
OF MERCHANTABILITY, FITNESS OR OTHERWISE WHICH EXTEND BEYOND THOSE 
STATED IN THE IMMEDIATELY PRECEDING SENTENCE.  Seller's liability and Buyer's 
exclusive remedy in any case of action (whether in contract, tort, breach of warranty or otherwise) 
arising out of the sale or use of any products, software, supplies, or materials is expressly limited 
to the replacement of such products, software, supplies, or materials on their return to Seller or, 
at Seller's option, to the allowance to the customer of credit for the cost of such items.  In no 
event shall Seller be liable for special, incidental, indirect, punitive or consequential damages.  
Seller does not warrant in any way products, software, supplies and materials not manufactured 
by Seller, and such will be sold only with the warranties that are given by the manufacturer 
thereof.  Seller will pass only through to its purchaser of such items the warranty granted to it by 
the manufacturer. 
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